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この資料は表記のバージ ョ ンの英語版を翻訳したもので、 内容に相違が生じる場合には原文を優先します。 資料によっては英語版の更新に対応していないものがあります。 
日本語版は参考用としてご使用の上、 最新情報につきましては、 必ず最新英語版をご参照ください。

概要

このアプリ ケーシ ョ ン ノートでは、 UltraScale+™ FPGA の重要な機能の 1 つであるマルチブートについて説明します。
UltraScale+ FPGA のマルチブート機能を使用する と、 FPGA アプリ ケーシ ョ ンの制御によ り複数の FPGA ビッ ト ス ト リー
ムを読み込むこ とができます。 FPGA アプリ ケーシ ョ ンがマルチブート動作を開始する と、 FPGA は別のコンフ ィギュ
レーシ ョ ン ビッ ト ス ト リームで リ コンフ ィギュレーシ ョ ンを実行します。 マルチブート動作が開始される と、 FPGA は通
常どおりのコンフ ィギュレーシ ョ ン プロセスを再開します。 この資料では、 ICAP を使用したマルチブート機能を実装す
る手順、 フォールバッ クを開始するさまざまな方法、 およびブート  ステータス  (BOOTSTS) レジスタを使用してマルチ
ブート またはフォールバッ ク動作をデバッグおよび検証する方法について説明します。 このアプ リ ケーシ ョ ン ノートに
は、 SPI モードで ICAP を使用した UltraScale+ FPGA のマルチブート機能を評価するためのリ ファレンス  デザインが付属
します。

このアプリ ケーシ ョ ン ノートの リ ファレンス  デザイン ファ イルは、 ザイ リ ンクスのウェブサイ トからダウンロードでき
ます。 デザイン ファ イルの詳細は、 「 リ ファレンス  デザイン」 を参照して ください。

はじめに

UltraScale+ FPGA のマルチブートおよびフォールバッ クは、 フ ィールドでのシステム アップデート をサポートする機能で
す。 UltraScale™ アーキテクチャは、 SPI x1、 x2、 および x4 でのマルチブート をサポート しており、 FPGA は複数のビッ
ト ス ト リームが格納されている  SPI フラ ッシュ  デバイスからビッ ト ス ト リームを読み込むこ とができます。 フ ィールド
でビッ ト ス ト リーム イ メージをアップグレードできるため、 設計者には非常に大きなメ リ ッ ト とな り ます。 FPGA のマル
チブート機能を使用する と、 リ アルタイムにイ メージを切り替えるこ とができます。 マルチブート  コンフ ィギュレー
シ ョ ン プロセス中にエラーが検出される と、 FPGA はフォールバッ ク機能を開始して、 検証済みのデザイン (ゴールデン 
イ メージ) をデバイスに読み込むこ とができます。

このアプリ ケーシ ョ ン ノートでは、 SPI (x1/x2/x4) コンフ ィギュレーシ ョ ン インターフェイスを使用する  UltraScale+ 
FPGA のマルチブートおよびフォールバッ ク機能について説明します。 こ こでは、 ザイ リ ンクスの KCU116 開発ボードに
実装された Micron 社製 MT25QU01 シ リアル NOR フラ ッシュ  メモ リ  デバイスを SPI x4 コンフ ィギュレーシ ョ ン モードで
使用します。 SPI x4 コンフ ィギュレーシ ョ ン インターフェイスの詳細は、 『UltraScale アーキテクチャ  コンフ ィギュレー
シ ョ ン ユーザー ガイ ド』 (UG570) [参照 1] を参照してください。

マルチブートおよびフォールバックの基本

FPGA アプリ ケーシ ョ ンがマルチブート動作を開始する と、 FPGA は別のコンフ ィギュレーシ ョ ン ビッ ト ス ト リームで リ
コンフ ィギュレーシ ョ ンを実行します。 マルチブート動作が開始される と、 FPGA は通常どおりのコンフ ィギュレーシ ョ
ン プロセスを再開し、 専用のマルチブート  ロジッ ク、 ウォーム ブート開始アドレス  (WBSTAR) レジスタ、 および 
BOOTSTS レジスタ以外のコンフ ィギュレーシ ョ ン メモ リ を消去します。 その後、 SPI フラ ッシュ  デバイスからの新しい
ビッ ト ス ト リームで リ コンフ ィギュレーシ ョ ンを実行します。
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フォールバックが開始される条件

 コンフ ィギュレーシ ョ ン中に次のエラーが生じる とフォールバッ クが開始されます。

• IDCODE エラー

• 巡回冗長検査 (CRC) エラー

• ウォ ッチド ッグ タイマーのタイムアウ ト  エラー

フォールバッ クは、 ビッ ト ス ト リーム オプシ ョ ンの BITSTREAM.CONFIG.CONFIGFALLBACK で有効にできます。
フォールバッ ク  リ コンフ ィギュレーシ ョ ン中は、 ウォッチド ッグ タイマーが無効になり ます。 フォールバッ ク  リ コン
フ ィギュレーシ ョ ンでエラーが発生する と、 コンフ ィギュレーシ ョ ンが停止し、 INIT_B と  DONE の両方が Low に維持さ
れます。

ゴールデン  イ メージ

FPGA に電源が投入される と、 アドレス  0x0 からゴールデン イ メージが読み込まれます (図 1)。 電源投入時には、 まず
ゴールデン イ メージが読み込まれます。 マルチブート開始イベン トが認識される と、 FPGA は上位アドレス空間からマル
チブート  イ メージを読み込みます。 マルチブート  イ メージは複数用意しておく こ とが可能で、 任意のデザインからほか
のイ メージの読み込みを開始できます。 マルチブート  イ メージのブート中にエラーが発生し、 コンフ ィギュレーシ ョ ン
を完了できなかった場合は、 フォールバッ ク回路がアドレス  0x0 からゴールデン イ メージの読み込みを開始します。

マルチブート  イ メージ

マルチブート  イ メージは上位アドレス空間から読み込まれます。 このイ メージのコンフ ィギュレーシ ョ ンが正常に終了
しなかった場合は、 フォールバッ クが自動的に開始され、 アドレス  0x0 に格納されているゴールデン イ メージが読み込
まれます。 フォールバッ ク機能は、 マルチブート  イ メージの読み込みが正常終了しなかった場合にシステムを回復し、
ゴールデン イ メージの読み込みを可能にします。

マルチブート  リファレンス デザイン

このセクシ ョ ンでは、 マルチブート  リ ファレンス  デザインの予想される動作、 およびリ ファレンス  デザインをコンパイ
ルして KCU116 評価ボードで検証する方法について説明します。 この リ ファレンス  デザインは、 まずゴールデン イ メー
ジで初期システムをセッ ト アップした後、 マルチブート機能のデモを開始します。

ゴールデン  イ メージによる初期システムのセッ トアップ

FPGA に電源が投入される と、 アドレス  0 からゴールデン イ メージが読み込まれます。 次に、 このゴールで イ メージの
デザインによってマルチブート  イ メージの読み込みが開始されます。 このよ うな方式は、 システム チェッ クを実行して
からランタイム イ メージを読み込む場合に適しています。 つま り、 システムのチェッ ク /診断機能をゴールデン イ メージ
に含めておき、 実際のシステムと しての動作はマルチブート  イ メージに含めておきます。 電源投入時に読み込まれる
ゴールデン イ メージによ り、 上位アドレス空間からのブートが開始されます。 マルチブート  イ メージは複数用意してお
く こ とが可能で、 任意のデザインからほかのイ メージの読み込みを開始できます。 上位アドレス空間からマルチブート  
イ メージを読み込み中にエラーが発生した場合は、 フォールバッ ク回路がアドレス  0x0 からゴールデン イ メージの読み
込みを開始します。 図 1 に、 ゴールデン イ メージの初期セッ ト アップ フローを示します。
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予想されるイメージの動作

電源を投入する と、 ゴールデン イ メージでコンフ ィギュレーシ ョ ンが実行され、 デザインの動作と して GPIO LED [0:7] 
が順番に点灯します。 読み込まれたイ メージは UART 経由で確認するこ と もできます。

ゴールデン イ メージで動作中に DIP SW13[1] を ト グル (0 → 1 → 0) する と、 IPROG が発行されて 0x01000000 のマルチ
ブート  イ メージへジャンプします。 この リ ファレンス  デザインは ICAP を使用してマルチブート  イ メージへジャンプし
ます。 IPROG が発行される と、 UART にメ ッセージが表示されます。

マルチブート  イ メージのコンフ ィギュレーシ ョ ンに成功する と、 デザインの動作と してすべての GPIO LED [0:7] が点滅
します。読み込まれたイ メージは UART 経由で確認するこ と もできます。マルチブート  イ メージで動作中に DIP SW13[1] 
が1 になる とシステムは FPGA の IDCODE を読み出し、 UART 経由で表示します。

ゴールデン イ メージで動作中に DIP SW13[4] を ト グル (0 → 1 → 0) する と、 IPROG によるジャンプは ICAP 経由で 
0x02000000 に発行されます。 このアドレスには有効なビッ ト ス ト リーム (コンフ ィギュレーシ ョ ン イ メージ) が存在し
ないため、 ウォ ッチド ッグ タイマーがタイムアウ ト してゴールデン イ メージへのフォールバッ クが開始されます。

CCLK を 51.0MHz に設定した場合、 SPI x4 インターフェイス経由のコンフ ィギュレーシ ョ ン時間は 1 秒未満です。 デフォ
ルトの CCLK 周波数では、 ウォッチド ッグ タイマーがタイムアウ トするのに約 15 秒かかり ます。

X-Ref Target - Figure 1

図 1: ゴールデン  イメージの初期フロー図
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マルチブート  リファレンス デザインのコンパイル

マルチブート  リ ファレンス  デザインは IP インテグレーター (IPI) を使用してインプリ メン ト されています。 ゴールデン  
イ メージおよびマルチブート  イ メージのファイルをコンパイルして生成するには次の手順を実行します。

1. [スタート ] → [すべてのプログラム] → [Xilinx Design Tools] → [Vivado 2017.1] → [Vivado] をク リ ッ ク して、 Vivado® 
ツールを起動します。

a. [Open Project] をク リ ッ ク します。 KCU116 マルチブート  リ ファレンス  デザイン 
(<Directory>\KCU116_MB.xpr) を開きます (図 1)。

b. このリ ファレンス  デザインは再コンパイルまたは SDK へのエクスポートが可能です。

- 再コンパイルするには、 [synth_1] を右ク リ ッ ク し、 [Reset Runs] → [Generate Bitstream] をク リ ッ ク します。

- SDK にエクスポートするには、 インプリ メン ト済みデザインを開いて [File] → [Export] → [Export Hardware] 
をク リ ッ ク します。

X-Ref Target - Figure 2

図 2: マルチブート  リファレンス デザインのプロジェク ト
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c. [File] → [Launch SDK] をク リ ッ ク して SDK を起動します (図 2)。
X-Ref Target - Figure 3

図 3: SDK の起動
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2. SDK でのソフ ト ウェアのコンパイル: SDK ではプロジェク トによって自動的に ELF ファ イルがビルド されます。 完
了したら、 SDK を終了して Vivado ツールに戻り ます (図 4)。

3. SDK で ELF ファ イルをコンパイルしたら、 [Associate ELF Files] コマンドを使用してデザインに関連付ける必要があ
り ます。 SDK の ELF ファ イルは次のディ レク ト リにあ り、 関連付けは Vivado プロジェク トで行います。

<Directory>\KCU116_MB.sdk\golden\Debug\golden.elf
<Directory>\KCU116_MB.sdk\multiboot\Debug\multiboot.elf

X-Ref Target - Figure 4

図 4: SDK で ELF ファイルをコンパイル
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4. いずれかの ELF ファ イルを右ク リ ッ ク して [Associate ELF Files] をク リ ッ ク します (図 5)。
X-Ref Target - Figure 5

図 5: Vivado ツールの [Associate ELF Files] ダイアログ ボックス
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5. [Multiboot.elf] の右にあるボタンをク リ ッ ク し、 [golden.elf] を選択して [OK] を 2 回ク リ ッ ク します (図 6)。

6. Vivado ツールで write_bitstream を実行します。 これで、 ゴールデン イ メージのビッ ト ス ト リームが生成されます。

7. 次の手順で上書きされないよ うに、 生成された BIT ファ イルの名前を変更します。

X-Ref Target - Figure 6

図 6: Vivado ツールで golden.elf ファイルを関連付け
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8. [Multiboot.elf] の右にあるボタンをク リ ッ ク し、 [multiboot.elf] を選択して [OK] を 2 回ク リ ッ ク します (図 7)。

9. Vivado ツールで write_bitstream を実行します。 これで、 マルチブート  イ メージのビッ ト ス ト リームが生成されます。

10. Create_MCS.tcl を使用して MCS ファ イルを生成します。

SDK のファイル golden.c は DIP SW13 を継続的に監視し、DIP SW13 のステータスに基づいて IPROG の発行を制御
します。 IPROG が発行される と、 ICAP には図 8 に示すデータ  シーケンスがプログラムされます。 この ICAP コマン
ドのシーケンスは、 『UltraScale アーキテクチャ  コンフ ィギュレーシ ョ ン ユーザー ガイ ド』 (UG570) [参照 1] の表
「ICAP を使用した IPROG のビッ ト ス ト リーム例」 に記載されているものです。

X-Ref Target - Figure 7

図 7: Vivado ツールで multiboot.elf ファイルを関連付け
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X-Ref Target - Figure 8

図 8: IPROG 用の ICAP コマンド
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図 9 に、 SDK の golden.c のマルチブート  アドレスを示します。

DIP SW13[1] を ト グル (0 → 1 → 0) すると、デザインは WBSTAR アドレスを 0x01000000 に設定して IPROG を発行します。

DIP SW13[4] を ト グル (0 → 1 → 0) すると、デザインは WBSTAR アドレスを 0x02000000 に設定して IPROG を発行します。

マルチブート  リファレンス デザインのビッ トス ト リーム設定

表 1 に、 マルチブート  リ ファレンス  デザインで使用するビッ ト ス ト リーム設定を示します。 これらの設定は、 ゴールデ
ン イ メージとマルチブート  イ メージの両方のビッ ト ス ト リームに共通です。 この表には、 デフォルト値、 設定可能な値、
およびリ ファレンス  デザインで使用されるオプシ ョ ンが記載されています。

X-Ref Target - Figure 9

図 9: SDK の golden.c のマルチブート  アドレス
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表 1: ビッ トス ト リーム設定

設定 デフォルト値 設定可能な値 デザインの設定 説明

BITSTREAM.CONFIG.
SPI_BUSWIDTH

None None、 1、 2、 4、 8 4 SPI バスをクワッ ド  (x4) モード  SPI コ
ンフ ィギュレーシ ョ ンに設定する。

BITSTREAM.CONFIG.
CONFIGFALLBACK

Enable Enable、 Disable Enable コンフ ィギュレーシ ョ ンが正常に完
了しなかった場合、 デフォルトの
ビッ ト ス ト リームの読み込みを有効
または無効にする。

BITSTREAM.CONFIG.
SPI_32BIT_ADDR

No No、 Yes Yes SPI 32 ビッ ト  アドレス形式を有効に
する。 256Mb またはそれよ り大規模
なス ト レージを持つ SPI デバイスの
場合に必要。
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ハードウェアでデザインを検証

このセクシ ョ ンでは、 ハードウェアでマルチブート  フォールバッ ク  リ ファレンス  デザインを検証する方法を説明します。

ハードウェア要件

• KCU116 評価ボード

• KCU116 の Digilent USB-to-JTAG モジュールに接続するための USB A-to-micro-B ケーブルまたはザイ リ ンクスのプ
ラ ッ ト フォーム ケーブル USB II

• KCU116 の USB UART インターフェイスに接続するための USB A-to-micro-B ケーブル

ソフ トウェア要件

• Vivado Design Suite 2017.1 (SDK を含む)

• TeraTerm またはその他のターミナル ソフ ト ウェア (UART 接続用)

° [Baud rate]: 9600

° [Parity]、 [Flow control]: None

° [Terminal setup] の [New-line] にある  [Receive]: Auto

BITSTREAM.CONFIG.
CONFIGRATE

3 2.7、 5.3、 8.0、
10.6、 21.3、 31.9、
36.4、 51.0、 56.7、
63.8、 72.9、 85.0、

102.0、 127.5、 170.0

51.0 CCLK を 51.0MHz に設定する。

BITSTREAM.CONFIG.
TIMER_CFG

- - 0x01FFFFFF コンフ ィギュレーシ ョ ン モードにお
けるウォッチド ッグ タイマーの値を
設定する。

BITSTREAM.GENERAL.
COMPRESS

False True、 False True 複数のフレームをビッ ト ス ト リーム
に一度に書き込む機能を使用して、
ビッ ト ス ト リーム (.bit) ファ イル
だけでなく、 ビッ ト ス ト リームのサ
イズを小さ くする。 Compress オプ
シ ョ ンを使用しても、 ビッ ト ス ト
リーム サイズが小さ くなる とは限ら
ない。

BITSTREAM.CONFIG.
SPI_FALL_EDGE

No No、 Yes Yes ク ロ ッ クの立ち下がりエッジを使用
して SPI データを取り込むよ うに 
FPGA を設定する。 これによ り タイ
ミ ング マージンが改善され、 コン
フ ィギュレーシ ョ ンのク ロ ッ ク  レー
ト を向上できるこ とがある。

表 1: ビッ トス ト リーム設定 (続き)

設定 デフォルト値 設定可能な値 デザインの設定 説明
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ボードのセッ トアップ

MODE ピンはマスター SPI に設定する必要があ り ます。 KCU116 ボードでは、 M0 と  M1 は固定値にハードワイヤード さ
れています。 M2 は SW21 を使用して 0 に設定します (図 10)。

DIP SW13 の初期設定は 0000 と します (図 11)。

X-Ref Target - Figure 10

図 10: SW21.6 を  0 に設定

X-Ref Target - Figure 11

図 11: DIP SW13[1:4] を  0000 に設定
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フラッシュのプログラム

リ ファレンス  デザインには生成済みの MCS ファイルが付属しており、 これを使用して KCU116 ボード上の SPI フラ ッ
シュ  MT25QU01 をプログラムできます。 表 2 に、 これらファ イルの説明を示します。

KCU116 ボードの SPI フラ ッシュをプログラムするには、 Vivado Tcl コンソールで Program_KCU116_SPI.tcl を実行し
ます。 この Tcl ファ イルは、 プログラムする  MCS ファ イルに応じて編集が必要となるこ とがあ り ます。 または、 Vivado 
ツールのハードウェア マネージャーを使用して、 表 2 に記載した MCS ファ イルを SPIx4 MT25QU01 フラ ッシュにプログ
ラムするこ と もできます。 フラ ッシュ  プログラ ミ ングの詳細は、 『Vivado Design Suite ユーザー ガイ ド : プログラムおよび
デバッグ』 (UG908) [参照 2] を参照してください。

マルチブート動作の検証

フラ ッシュ  デバイスにプログラムしたイ メージ (Golden_n_Multiboot.mcs) で FPGA をブートするには、 KCU116 
ボードの SW5 を使用して PROGRAM_B をパルスします。 FPGA が SPI フラ ッシュのゴールデン ビッ ト ス ト リームで正常
にコンフ ィギュレーシ ョ ンされているかを検証します。 検証方法は次のとおりです。

• ボード上の DONE ピン LED が点灯しているか。

• GPIO LED [0:7] が順番に点灯し、 ゴールデン ビッ ト ス ト リームが正常に読み込まれたこ とを示しているか。

• UART ターミナルに図 12 のよ うなメ ッセージが表示されているか。

• Vivado IDE で FPGA を右ク リ ッ ク して [Hardware Device Properties] をク リ ッ ク し、 デバイスを リ フレッシュします。

• Vivado IDE の [Hardware Device Properties] ウ ィンド ウで、 [REGISTER] の下にある  [BOOT_STATUS] と  
[CONFIG_STATUS] を展開表示します。 BOOT_STATUS レジスタを見る と、 通常のコンフ ィギュレーシ ョ ンに成功し
たこ とが確認できます。 CONFIG_STATUS レジスタでは、 DONE_PIN が High を示しています (図 13)。

表 2: MCS ファイルの説明

ファイル名 説明

Golden_n_Multiboot.mcs ゴールデンおよびマルチブート  イ メージ。 ゴールデン イ メージとマ
ルチブート  イ メージ両方のコンフ ィギュレーシ ョ ンが正常に行われる
こ とを確認できます。

Golden_n_Multiboot_CRC_Err.mcs マルチブート  イ メージの CRC が破損しています。 マルチブート  イ
メージを読み込むと  CRC エラーが発生し、 フォールバッ クが開始し
ます。

Golden_n_Multiboot_ID_Err.mcs マルチブート  イ メージの FPGA IDCODE が破損しています。 マルチ
ブート  イ メージを読み込むと  IDCODE エラーが発生し、 フォールバッ
クが開始します。

X-Ref Target - Figure 12

図 12: ゴールデン  イメージの場合の UART の表示

X17890-050517

https://japan.xilinx.com
https://japan.xilinx.com/about/feedback.html?docType=Application_Notes&docId=XAPP1296&Title=UltraScale+%20FPGA%20%26%2312398%3B%20ICAP%20%26%2312434%3B%26%2320351%3B%26%2329992%3B%26%2312377%3B%26%2312427%3B%20%26%2312510%3B%26%2312523%3B%26%2312481%3B%26%2312502%3B%26%2312540%3B%26%2312488%3B%26%2312362%3B%26%2312424%3B%26%2312403%3B%26%2312501%3B%26%2312457%3B%26%2312540%3B%26%2312523%3B%26%2312496%3B%26%2312483%3B%26%2312463%3B&releaseVersion=1.0&docPage=13


ハードウェアでデザインを検証

XAPP1296 (v1.0) 2017 年 6 月 23 日  14
japan.xilinx.com

ゴールデン イ メージが正常に読み込まれたこ とを確認したら、 DIP SW13[1] を ト グル (0 → 1 → 0) します。 DONE LED が
一瞬消灯し、 マルチブート  イ メージが読み込まれます。 IPROG が発行される と、 UART に図 14 のよ うなメ ッセージが表
示されます。

FPGA が SPI フラ ッシュのマルチブート  ビッ ト ス ト リームで正常にコンフ ィギュレーシ ョ ンされているかを検証します。
検証方法は次のとおりです。

• ボード上の DONE ピン LED が点灯しているか。

• GPIO LED [0:7] ですべての LED が点滅 (オン/オフ) し、 マルチブート  ビッ ト ス ト リームが正常に読み込まれたこ とを
示しているか。

• UART ターミナルに図 15 のよ うなメ ッセージが表示されているか。

• Vivado IDE で FPGA を右ク リ ッ ク して [Hardware Device Properties] をク リ ッ ク し、 デバイスを リ フレッシュします。

• Vivado IDE の [Hardware Device Properties] ウ ィンド ウで、 [REGISTER] の下にある  [BOOT_STATUS] と  
[CONFIG_STATUS] を展開表示します。 BOOT_STATUS レジスタを見る と、 マルチブート  ビッ ト ス ト リームへのジャ
ンプの要因となった IPROG (INTERNAL_PROG) フラグが High であるこ とを確認できます。 CONFIG_STATUS レジス
タでは、 DONE_PIN が High を示しています (図 16)。

X-Ref Target - Figure 13

図 13: ゴールデン イメージの BOOT_STATUS
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X-Ref Target - Figure 14

図 14: IPROG が発行されたことを示す UART の表示

X-Ref Target - Figure 15

図 15: マルチブート  イメージの場合の UART の表示
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マルチブート  イ メージが正常に読み込まれたこ とを確認したら、 DIP SW13[1] を 1 にします。 これによってデザインは 
FPGA IDCODE を読み出し、 UART 経由で表示します (図 17)。

X-Ref Target - Figure 16

図 16: マルチブート  イメージの BOOT_STATUS
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X-Ref Target - Figure 17

図 17: マルチブート  イメージが FPGA IDCODE を読み出して UART に表示
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フォールバックの例 ‐ CRC エラー

フラ ッシュ  デバイスにプログラムしたイ メージ (Golden_n_Multiboot_CRC_Err.mcs) で FPGA をブートするには、
KCU116 ボードの SW5 で PROGRAM_B をパルスします。 ゴールデン イ メージが正常に読み込まれたこ とを確認したら、
DIP SW13[1] を ト グル (0 → 1 → 0) します。 DONE LED が一瞬消灯し、 FPGA がマルチブート  イ メージの読み込みを試み
ます。 このマルチブート  イ メージは破損しているため、 FPGA はフォールバッ ク してゴールデン ビッ ト ス ト リームを読
み込みます。

• Vivado IDE で FPGA を右ク リ ッ ク して [Hardware Device Properties] をク リ ッ ク し、 デバイスを リ フレッシュします。

• Vivado IDE の [Hardware Device Properties] ウ ィンド ウで、 [REGISTER] の下にある  [BOOT_STATUS] と  
[CONFIG_STATUS] を展開表示します。 BOOT_STATUS レジスタを見る と、 ジャンプの要因となった IPROG 
(INTERNAL_PROG)、 CRC エラー、 フォールバッ クのフラグが High であるこ とが確認できます。 CONFIG_STATUS 
レジスタでは、 DONE_PIN が High を示しています (図 18)。

X-Ref Target - Figure 18

図 18: CRC エラーの場合の BOOT_STATUS
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フォールバックの例 ‐ IDCODE エラー

フラ ッシュ  デバイスにプログラムしたイ メージ (Golden_n_Multiboot_ID_Err.mcs) で FPGA をブートするには、
KCU116 ボードの SW5 で PROGRAM_B をパルスします。 ゴールデン イ メージが正常に読み込まれたこ とを確認したら、
DIP SW13[1] を ト グル (0 → 1 → 0) します。 DONE LED が消灯し、 FPGA がマルチブート  イ メージの読み込みを試みます。
このマルチブート  イ メージの IDCODE は意図的に破損したものを使用しているため、 FPGA はフォールバッ クしてゴー
ルデン ビッ ト ス ト リームを読み込みます。

• Vivado IDE で FPGA を右ク リ ッ ク して [Hardware Device Properties] をク リ ッ ク し、 デバイスを リ フレッシュします。

• Vivado IDE の [Hardware Device Properties] ウ ィンド ウで、 [REGISTER] の下にある  [BOOT_STATUS] と  
[CONFIG_STATUS] を展開表示します。 BOOT_STATUS レジスタを見る と、 ジャンプの要因となった IPROG 
(INTERNAL_PROG)、 ID エラー、 フォールバッ クのフラグが High であるこ とが確認できます。 CONFIG_STATUS レ
ジスタでは、 DONE_PIN が High を示しています (図 19)。

X-Ref Target - Figure 19

図 19: IDCODE エラーの場合の BOOT_STATUS
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フォールバックの例 ‐ ウォッチド ッグ タイマー

フラ ッシュ  デバイスにプログラムしたイ メージ (1) で FPGA をブートするには、 KCU116 ボードの SW5 で PROGRAM_B 
をパルスします。

ゴールデン イ メージが正常に読み込まれたこ とを確認したら、 DIP SW13[4] を ト グル (0 → 1 → 0) します。 DONE LED が
消灯し、 FPGA がマルチブート  イ メージの読み込みを試みます。 ジャンプ先のアドレス  0x02000000 には有効なコン
フ ィギュレーシ ョ ン イ メージが存在しないため、 FPGA ウォ ッチド ッグ タイマーが約 15 秒後にタイムアウ ト し、 フォー
ルバッ クが開始します。 FPGA はフォールバッ ク してゴールデン ビッ ト ス ト リームを読み込みます。

• Vivado IDE で FPGA を右ク リ ッ ク して [Hardware Device Properties] をク リ ッ ク し、 デバイスを リ フレッシュします。

• Vivado IDE の [Hardware Device Properties] ウ ィンド ウで、 [REGISTER] の下にある  [BOOT_STATUS] と  
[CONFIG_STATUS] を展開表示します。 BOOT_STATUS レジスタを見る と、 ジャンプの要因となった IPROG 
(INTERNAL_PROG)、 ウォ ッチド ッグ タイムアウ ト  エラー、 フォールバッ クのフラグが High であるこ とが確認でき
ます。 CONFIG_STATUS レジスタでは、 DONE_PIN が High を示しています (図 20)。

1. イ メージに使用する  MCS ファ イルは、 付属のものならどれでもかまいません。

X-Ref Target - Figure 20

図 20: ウォッチド ッグ タイムアウト  エラーの場合の BOOT_STATUS
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デバッグ

このセクシ ョ ンでは、 SPI フラ ッシュを使用するマルチブートの一般的な問題をデバッグする際のチェッ ク リ ス ト を示し
ます。

デザイン

• ゴールデン イ メージとマルチブート  イ メージの両方に対して、 すべてのビッ ト ス ト リーム プロパティが適切に設定
されているか (表 2 参照)。

• すべての SPI ビッ ト ス ト リーム プロパティが適切に設定されているか (表 2 参照)。

• フラ ッシュ  プログラ ミ ング ファ イルを生成するためのコマンドに適切なオプシ ョ ンとアドレス設定がすべて含まれ
ているか。 Create_MCS.tcl を参照してください。

• Golden.c で指定した IPROG ジャンプ先アドレス と、 MCS ファ イルを再生成する際に指定したアドレスが一致して
いるか。

ハードウェア

• MODE ピンがマスター SPI コンフ ィギュレーシ ョ ンに設定されているか。

• DIP SW13 が初期状態ですべて 0 に設定されているか。

• UART ボー レートが 9600 に設定されているか。

• デザインでフラ ッシュのプログラ ミ ングを実行する前に、 フラ ッシュ  デバイスが完全に消去されているか。 消去さ
れたかは、 ブランク  チェッ ク  オプシ ョ ンで確認できます。

• マルチブート  リ ファレンス  デザインのデバッグでは、 BOOT_STATUS および CONFIG_STATUS レジスタを使用して
エラーや動作の問題を確認します。 レジスタを読み出す前に、 デバイスのリ フレッシュが完了しているこ とを確認し
て ください。

• SW16 がリ ファレンス  デザインのリセッ トにマップされているか。 このスイ ッチを押すとデザインがリセッ ト状態に
なり ます。

• PROG_B SW5 スイ ッチが解放されているか。

まとめ

このアプリ ケーシ ョ ン ノートでは、 フ ィールドでシステムをアップデート した り異なるコンフ ィギュレーシ ョ ン イ メー
ジを リ アルタイムで読み込んだりする場合に役立つ UltraScale+ FPGA のマルチブート機能を使用する方法について説明し
ました。 SPI (x4) コンフ ィギュレーシ ョ ン インターフェイスでこの機能を実装する際の参考にしてください。 マルチブー
ト機能の動作を評価する際に使用できる  KCU116 ボード用のリ ファレンス  デザインが提供されています。
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リファレンス デザイン

このアプリ ケーシ ョ ン ノートの リ ファレンス  デザイン ファ イルは、 ザイ リ ンクスのウェブサイ トからダウンロードでき
ます。 表 3 に、 リ ファレンス  デザインの詳細を示します。

参考資料

注記:日本語版のバージ ョ ンは、 英語版よ り古い場合があ り ます。

1. 『UltraScale アーキテクチャ  コンフ ィギュレーシ ョ ン ユーザー ガイ ド』 (UG570: 英語版、 日本語版)

2. 『Vivado Design Suite ユーザー ガイ ド : プログラムおよびデバッグ』 (UG908: 英語版、 日本語版)

3. 『Vivado Design Suite Tcl コマンド  リ ファレンス  ガイ ド』 (UG835: 英語版、 日本語版)

4. 『KCU116 評価ボード  ユーザー ガイ ド』 (UG1239)

5. 『エンベデッ ド  システム ツール リ ファレンス  マニュアル』 (UG1043: 英語版、 日本語版)

表 3: リファレンス デザインの詳細

パラメーター 説明

全般

開発者 Guruprasad Kempahonnaiah

ターゲッ ト  デバイス UltraScale+ FPGA

ソース  コードの提供 あ り

ソース  コードの形式 Verilog、 C

既存のザイ リ ンクス  アプリ ケーシ ョ ン ノート / リ ファレンス  デザイン、
またはサードパーティからデザインへのコード /IP の使用

N/A

シミ ュレーシ ョ ン

論理シ ミ ュレーシ ョ ンの実施 N/A

タイ ミ ング シ ミ ュレーシ ョ ンの実施 N/A

論理シ ミ ュレーシ ョ ンおよびタイ ミ ング シ ミ ュレーシ ョ ンでのテス トベ
ンチの利用

N/A

テス トベンチの形式 N/A

使用したシ ミ ュレータ /バージ ョ ン N/A

SPICE/IBIS シ ミ ュレーシ ョ ンの実施 N/A

インプリ メンテーシ ョ ン

使用した合成ツール/バージ ョ ン Vivado Design Suite 2017.1

使用したインプリ メンテーシ ョ ン ツール/バージ ョ ン Vivado Design Suite 2017.1

ザイ リ ンクス  SDK 2017.1

スタティ ッ ク  タイ ミ ング解析の実施 N/A

ハードウェア検証

ハードウェア検証の実施 あ り

使用したハード ウェア プラ ッ ト フォーム KCU116 評価ボード
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改訂履歴

次の表に、 この文書の改訂履歴を示します。

法的通知
本通知に基づいて貴殿または貴社 (本通知の被通知者が個人の場合には 「貴殿」、 法人その他の団体の場合には 「貴社」。 以下同じ ) に開

示される情報 (以下 「本情報」 といいます) は、 ザイ リ ンクスの製品を選択および使用するこ とのためにのみ提供されます。 適用される

法律が許容する最大限の範囲で、 (1) 本情報は 「現状有姿」、 およびすべて受領者の責任で (with all faults) とい う状態で提供され、 ザイ リ

ンクスは、 本通知をもって、 明示、 黙示、 法定を問わず (商品性、 非侵害、 特定目的適合性の保証を含みますがこれらに限られません)、
すべての保証および条件を負わない (否認する ) ものと します。 また、 (2) ザイ リ ンクスは、 本情報 (貴殿または貴社による本情報の使用

を含む) に関係し、 起因し、 関連する、 いかなる種類 ・ 性質の損失または損害についても、 責任を負わない (契約上、 不法行為上 (過失の

場合を含む)、 その他のいかなる責任の法理によるかを問わない) ものと し、 当該損失または損害には、 直接、 間接、 特別、 付随的、 結

果的な損失または損害 (第三者が起こした行為の結果被った、 データ、 利益、 業務上の信用の損失、 その他あらゆる種類の損失や損害を

含みます) が含まれるものと し、 それは、 たとえ当該損害や損失が合理的に予見可能であったり、 ザイ リ ンクスがそれらの可能性につい

て助言を受けていた場合であったと しても同様です。 ザイ リ ンクスは、 本情報に含まれるいかなる誤り も訂正する義務を負わず、 本情

報または製品仕様のアップデート を貴殿または貴社に知らせる義務も負いません。 事前の書面による同意のない限り、 貴殿または貴社

は本情報を再生産、 変更、 頒布、 または公に展示してはなり ません。 一定の製品は、 ザイ リ ンクスの限定的保証の諸条件に従う こ と と

なるので、 https://japan.xilinx.com/legal.htm#tos で見られるザイ リ ンクスの販売条件を参照して ください。 IP コアは、 ザイ リ ンクスが貴殿

または貴社に付与したライセンスに含まれる保証と補助的条件に従う こ とにな り ます。 ザイ リ ンクスの製品は、 フェイルセーフと して、

または、 フェイルセーフの動作を要求するアプリ ケーシ ョ ンに使用するために、 設計されたり意図されたり していません。 そのよ うな

重大なアプリ ケーシ ョ ンにザイ リ ンクスの製品を使用する場合のリ スク と責任は、 貴殿または貴社が単独で負う ものです。

https://japan.xilinx.com/legal.htm#tos で見られるザイ リ ンクスの販売条件を参照してください。

自動車用のアプリケーシ ョ ンの免責条項

オートモーティブ製品 (製品番号に 「XA」 が含まれる ) は、 ISO 26262 自動車用機能安全規格に従った安全コンセプ ト または余剰性の機

能 ( 「セーフティ設計」 ) がない限り、 エアバッグの展開における使用または車両の制御に影響するアプリ ケーシ ョ ン  ( 「セーフティ  ア
プリ ケーシ ョ ン」 ) における使用は保証されていません。 顧客は、 製品を組み込むすべてのシステムについて、 その使用前または提供前

に安全を目的と して十分なテス ト を行う ものと します。 セーフティ設計なしにセーフティ  アプリ ケーシ ョ ンで製品を使用する リ スクは

すべて顧客が負い、 製品の責任の制限を規定する適用法令および規則にのみ従う ものと します。

© Copyright 2017 Xilinx, Inc. Xilinx、 Xilinx のロゴ、 Artix、 ISE、 Kintex、 Spartan、 Virtex、 Vivado、 Zynq、 およびこの文書に含まれるその

他の指定されたブランドは、 米国およびその他各国のザイ リ ンクス社の商標です。 すべてのその他の商標は、 それぞれの保有者に帰属

します。

この資料に関するフ ィードバッ クおよびリ ンクなどの問題につきましては、 jpn_trans_feedback@xilinx.com まで、 または各ページの右下

にある  [フ ィードバッ ク送信] ボタンをク リ ッ クする と表示されるフォームからお知らせください。 いただきましたご意見を参考に早急

に対応させていただきます。 なお、 このメール アドレスへのお問い合わせは受け付けており ません。 あらかじめご了承ください。
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